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Chapter1

About This Product

What is an Interwoven Turbo Product?

Interwoven® Turbo is a solution software product that enables and accelerates the integration of
Interwoven TeamSite® with a number of eBusiness suites. Each Turbo product provides a standardized
set of integration points and baseline capabilities for a specific partner platform. However, Turbo
does not restrict the customer to that single platform, but rather makes all of them available. Because
of Turbo’s modular approach and broad-based availability, TeamSite can be coupled with any of the
leading eBusiness suites for which a Turbo has been developed.

The advantages of Interwoven Turbo are not limited to the flexibility and standardization it facilitates;
Turbo also builds customer value by increasing Return On Investment (ROI) in the following ways:

Accelerates time-to-Web: Turbo gets you up and running fast by eliminating the guesswork in
getting enterprise products working together. Professional service expenditures can be targeted to
adapting the solution to best meet the customer’s environment rather than figuring out how to get
the two products to work together.

Extends Investment: As part of Interwoven’s solution software, Turbo is licensed under a two-
year subscription that entitles a customer to any Turbo upgrades released during the period.

Increases Productivity: Turbo extends and enhances TeamSite’s native capability to support all
user types, from business users to Web and application code developers. It provides additional
mechanisms for interacting with the eBusiness suite that help all contributors be more effective.

Content Reuse: Interwoven Turbo will support a number of best-of-breed eBusiness suites so
that customers can reuse content when they modify or build new applications.

Operational Stability: Turbos, like all Interwoven products, are fully supported by Interwoven’s
enterprise-class technical support.
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Features of the Turbo Product Family

Interwoven Turbo extends the functionality of TeamSite by providing components that seamlessly
interface with eBusiness suite applications, such as Web application servers and personalization
servers. Through these components, Turbo can provide an expanded set of capabilities to TeamSite
users, including:

« Virtualization of dynamic Web applications during development

« TeamSite users can walk through an application in their workarea just like a customer
« Support for personalization servers through templating and metadata capture

« Workflow approval of content prior to submission

 Deployment of content (file system and database) to the production environment

« Asimple business-user interface for contributing content to the \Web properties

Application Server Component

“Out of the box” TeamSite virtualizes static VWeb content, which allows an entire Web site to be
previewed from within a workarea while still in development. The Turbo application server
component takes this one step further and provides the virtualization of dynamic content, such as
JSPs, EJBs, ASPs, JHTML and servlets. This feature accelerates Web development by enabling in-
context QA of the entire site from a workarea without disrupting the work of other contributors.

Additionally, Turbo usually provides an augmentation to the TeamSite User Interface (Ul) to interact
with the application server and register application components, and provide a mechanism for
switching between “local” and “shared” server instances from within the TeamSite workarea.

Personalization Server Component

Turbo also includes a component for deploying template-entered data and metadata to repositories
used by personalization servers and eCommerce applications. The dynamic targeting of specific
content to particular users or groups can be based on comparisons of this data to the personalization
schema constructed for a given business model. TeamSite supports this through Turbo by mapping
metadata and the content personalization database so that content can be delivered using the correct
rules. Furthermore, TeamSite stores the personalization rules and thus they can be versioned.
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Business-User Support

Business users are the knowledge and process experts within a company. It is crucial that their content
contribution be disseminated across the enterprise and effectively published to WWeb properties.
Among the many ways in which Interwoven Turbo facilitates this are providing whole-site preview
capability while still in development, updating repositories with content created in TeamSite
templating or with specific metadata captured on Web site assets, and enforcing workflow approvals
for content submission. Business-user support is a critical function of the Turbo product and will be
discussed in greater detail below.

Architectural Overview

General Turbo Architecture

Turbo connects the TeamSite content management functionality to various delivery systems while
augmenting the TeamSite native virtualization, templating and metadata capabilities. Development
tools and delivery systems are all interconnected by the Turbo architecture. The result is that the
customer’s development environment is fully vertically integrated, from the initial back-end
development of content to its deployment.
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Application Servers and Virtualization

The Turbo design is geared toward implementations with application servers. The TeamSite server,
proxy server and Web server all interact with the application server to provide virtualization of
dynamic, application-driven Web sites, as well as the native capability of TeamSite to virtualize static
Web sites. At a high level, this is accomplished by configuring the TeamSite Proxy Server to redirect
requests for certain file types to the application server and then pointing the application server toward
the correct area of the originating request.

Browser TeamSite

\ 4

|~ | App
— | Server
4

o it

Application Server Integration

Instances of an application server can be set up to correspond either to a single TeamSite workarea or
to be shared by multiple workareas, depending upon which types of users are involved. For example,
presentation layer developers, such as content contributors and Web page designers, can share a single
instance of the application server. On the other hand, Java™ developers should each have a dedicated
instance (one application server instance per TeamSite workarea) because their work can affect the
behavior of the application server. Turbo provides the flexibility to implement either of these
architectures.
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Who Can Use This Product?

Interwoven Turbo extends the inherent capability of TeamSite to support multiple types of users. As
the diagram below shows, TeamSite with Turbo can connect back-end content contributors and their
work to the databases, applications and repositories that power an enterprise-level Web site. The
following section will describe three types of contributors—business users, application developers,
and presentation-level developers—and discuss how they can benefit from the functionality provided

by Turbo.
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Business Users

Numerous Interwoven Turbo features let business users add their unique knowledge and expertise to
Web properties. These features include templating, structured metadata capture coupled with
personalization server support, and workflow approval.

Templating

Templating provides a means for the business user to contribute content through a simple, intuitive
interface and then target that content to any number of repositories within the eBusiness platform.
Templates are thus a means to capture the intellectual property of the business experts, who can also
preview their content before submission. Specifically, the business users can:

« Enter structured content through a data capture template (DCT) based on a schema required by
the personalization targeting rules.

« Preview content with presentation template applied to see how it will appear to the end user, and
view dynamic content to test personalization rules.

e Publish content to Web properties through a structured and tailored mechanism.

Metadata Capture
Turbo lets business users:

« Apply metadata (tag) Web site assets based on a name/value pair specified in the repository schema
and then ensure the deployment of these assets and metadata to the repository.

« Manage the development of and version control of personalization server rules.

Workflow Approval

The use of workflows to approve content before it is submitted provides safeguards and enforces
business process.

11
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Application Developers
Application developers develop and maintain the “application” logic and code for an application server.
They are primarily concerned with the coding of the business logic and rules and managing access to

databases and legacy applications. Turbo helps them through server selection, component registration,
and site virtualization.

Turbo benefits application developers with:

« Simplified administration—Full source control for applications using a single TeamSite server.

o Parallel development—Developers can work in multiple workareas creating different pieces of the
same application without conflicts.

« Simplified, in-context QA—Developers can preview the entire WWeb site from within a single
workarea.

« Full control—\Versioning, workflow, and rollback capabilities provided by TeamSite.

« Distributed development—Local or remote team development.

« Direct access for JSP files—Developers can preview JSP files directly from the TeamSite browser
interface.

« Managed deployment of J2EE entities—A Ul for managing deployment of J2EE entities to the
application server and then for switching between server instances based on the environment.

Presentation Layer Developers

Presentation-layer developers are the content contributors and WWeb developers who create and
modify JSP tags, JavaScript, HTML, DHTML, images and other site elements that will appear at the
presentation layer. They are mainly concerned with the layout, design, and functionality of the Web
pages. Interwoven Turbo provides support to presentation layer developers by providing in-context
QA of dynamic Web sites. This can be done while the site is still in development, thus the
development cycle is accelerated.
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About This Document

The following Turbo Product Guide discusses the solution and implementation of TeamSite with one
of the major eBusiness platform servers. It contains a description of the installation, configuration and
implementation of the specific solution that can be used to get the suite component up and running
with full TeamSite functionality.

Although this document contains general information about Turbo products that may be similar to
other platforms and servers, for detailed information consult the product guide about the specific
Turbo that will be implemented.

Note: When describing the installation and configuration of the Turbo product, this document refers
to TeamSite. If your license is for the TeamXpress™ product instead, the information contained
in this document still applies to your product with the possible exception of branch creation.
For further details, see the Interwoven TeamXpress for Multiplatforms, WebSphere Edition
Administration Guide.

13
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Chapter 2

Introduction

Overview

This document describes the installation and configuration of Interwoven Turbo for IBM® Enterprise
Information Portal (EIP) and Content Manager. This Turbo integrates TeamSite 4.5.1 with the IBM
Enterprise Information Portal Version 7.1.2 and IBM Content Manager Version 7.1.

This product guide does not cover the full installation of TeamSite, EIP, or Content Manager, nor
does it cover the usage of these products. It is expected that users and administrators of these software
packages are familiar with installing and using TeamSite, EIP, and Content Manager.

Note: Installation of the EIP and Content Manager Turbo components requires that the WebSphere
Application Server is already installed. For more information on this, refer to the Interwoven
Turho Product Guide for IBM WebSphere Application Server.

Prerequisite Software

For the the Turbo product for EIP and Content Manager to be installed, certain software components
first must be installed for EIP, Content Manager and the Turbo itself.

 The Turbo product requires the following software components:
— Windows NT® or Windows® 2000
— TeamSite 4.5.1
— TeamSite Templating 4.5.1
— TeamSite Templating Java Client
— IBM WebSphere® Application Server 3.5.3 (release 3.5 + fix pack 3)

— One additional eFix for fix pack 3 - PQ46019 (either download from the eFix site or request
through IBM support)

— Enterprise Information Portal V 7.1.2 and Content Manager V7.1.0

15
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— Database for the WebSphere Application Server
— Web server for TeamSite (11S 4.0, NES 3.6.3 or Apache for Solaris™ is recommended)
— Web server for WebSphere Application Server
— The Templating Client needs Java Ul support and JDK 1.2.2 or higher.
« Inaddition, EIP requires that you have the following software components installed:
— Database (usually IBM DB2 UDB, which is included with EIP)
— Java 2 SDK (included with EIP)
— Browser version that supports frames and cascading style sheets

Note: Some features of EIP require additional software components; for the full set of software
requirements for EIP, refer to the Planning and Installing Enterprise Information Portal manual.

« Content Manager requires that you have the following software components installed:
— Database and toolkits
— Java 2 SDK (included with Content Manager)
— Browser version that supports frames and cascading style sheets
— Microsoft Visual C++ Version 6

— Install the Content Manager fix associated with APAR IR 44982 if you plan to use the IBM Video
Charger with Contant Manager.

Note: Some features of Content Manager require additional software components; for the full set of
software requirements for Content Manager, refer to the Planning and Installing Content
Manager manual.

16
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Prerequisite Hardware

For TeamSite server configuration requirements, see the recommendations in the Administering
TeamSite manual.

For hardware requirements for the EIP server, see the Planning and Installing Enterprise Information
Portal manual.

For hardware requirements for the Content Manager server, see the Planning and Installing Content
Manager manual.

17
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Architectural Overview

The architecture of Interwoven Turbo for EIP and Content Manager is shown in the following
diagram:
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Turbo Architecture

The Turbo product enables TeamSite users to retrieve and select assets stored in IBM Content
Manager or other data stores managed by EIP and to store these asset references into a DCR during
the content entry process. They are embedded as DCR values through the EIP search GUI lauched by
the templating callout facility. Assets can be an images, video files, audio files, or text files.

18

Interwoven Turbo Product Guide



Some sample presentation templates that come with Turbo use Perl function calls to resolve EIP
references and retrieve the asset first, then include the actual content of the asset from repositories
outside the TeamSite environment during templating page generation process. This scenario is limited
to pure ASCII text files only.

Other presentation templates will generate a reference URL to a servlet for content retrieval during
JSP runtime (JSPs with embedded EIP references are generated by TeamSite Templating). In other
words, if users have a virtualized workarea through the WebSphere Application Server Turbo
component, they will be able to preview any JSP page that includes the EIP reference content.

Content Manager is the datastore for a wide variety of content types. You can connect to Content
Manager directly through EIP or as part of a federated search for searching and retrieving content.

The typical setup runs TeamSite, EIP Client Kit, and Content Manager and WebSphere Application
Server on separate servers.

19
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Chapter3

Installation and Configuration

The installation procedure for Turbo 2.0 for IBM EIP and Content Manager consists of first installing
EIP and Content Manager and then also installing Turbo components on the WebSphere Application
Server, on the TeamSite server, and on the TeamSite Templating client. The administrator installing

these components must have write-level file permissions for the directories in which they will be
placed. It is recommended that the components be installed on separate servers.

System Overview

A typical system configuration is shown in the following diagram:
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Installing Content Manager

The installation procedure here is intended for an initial installation of a basic Content Manager system
on a workstation. For complete information on installing Content Manager, see the Planning and
Installing Content Manager manual supplied with Content Manager.

Pre-Installation Procedure

Before you begin the Content Manager installation, ensure that you have the following items and
information:

All of the memory, hardware, and software requirements to install Content Manager.

A user account that can be used to perform the installation. The account must be local and belong
to the Admi ni st r at or group. The user ID must follow the requirements for your relational
database.

A relational database; IBM DB2 UDB is supplied with Content Manager.

Microsoft Visual C++. Ensure that the Visual C++ environment variable and program are
configured for the Content Manager administrator’s user 1D.

Installation Procedures

. Ensure that you are logged in using a User ID with adni ni st r at or privileges.

. Start the Content Manager installation from the CD by entering the following at a DOS prompt:

x:\wi n\| ang_code\ set up.
Where x is the local CD drive and | ang_code is the directory for your language. For English, the
directory is ENU.

. Select the installation program language.

. Select the Content Manager components you want to install. At a minimum, install the Li br ary

server, Qbj ect server, and Syst emAdni ni strati on components.

. Set up the configuration panel for installation.

— On the Client/Server Configuration tab: Specify the database you have and make sure that
Library Server and Object Server databases are checked. Check to use a network table file.

22
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— On the Library Server Database tab: Specify the drive for the database and accept the other
defaults.

— On the Object Server Database tab: Specify the drive and accept the defaults.

— If you are using DB2 UDB, on the Windows Service Configuration, specify the password for the
user 1D for your databases.

— On the Network Table Generation tab: Accept the defaults.
— On the System Administration Gateway Configuration tab: Accept the defaults.

6. After completing the configuration panels, click Next on the Start Copying Files window to install
Content Manager.

7. After installing Content Manager, install the Content Manager Client for Windows to use with
your Content Manager system. You should install the Client Application and Common Files com-
ponent. Install the Toolkit and DBCS files if you need them. Follow the installation on the installa-
tion screens to complete the install.

8. After successfully installing, you are ready to set up your Content Manager system and begin stor-
ing the documents and other content data.

Removing Content Manager

See the Planning and Installing Content Manager manual for information on removing Content Manager
from your system.

23
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Installing EIP on the WebSphere Application Server

On the WebSphere Application Server computer, you should install the following components:
« WebSphere Application Server

« Enterprise Information Portal

« Database (DB2 UDB for EIP)

This installation procedure assumes that you have installed the WebSphere Application Server with
the appropriate updates; see the Interwoven Turbo Product Guide for IBM WebSphere Application Server for
more information.

Ensure that the Y drive is mapped to the TeamSite i wser ver share,\\ts_host _name\i wser ver,
where t s_host _hone points to the location of TeamSite.

Installing EIP

The installation of the EIP server is described in the Planning and Installing Enterprise Information Portal
manual. When installing on the WebSphere Application Server computer, note the following:

« Select the EIP Development Workstation button for the type of machine to install. This is the
third option on the EIP installation screen.

 Check the EIP Administration check box in the component list, then check the Admin Client
and Admin Database check boxes to install them.

« Similarly, select the following connectors to install .
— Federated connector
— Content Manager connector

« In the Network Table Generation dialog box specify the server names, ports and host names for
Content Manager. If your Content Manager is on a remote system, you must supply these values.

« You can select the defaults for the other installation options. If you plan to connect to an existing
text search or image search system, enter the information for those systems on the appropriate
installation screens.
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« If you chose to generate the Network Table (FRNOLI NT. TBL) later, you can use the following
commands to do so:

1. From a command-prompt window, change to the directory where Content Manager is installed,
default is f r nr oot .

2. Type frnnlinc
3. Type 1 to add a server entry.

4. Atthe Sel ect Server Location (Current: NONE) prompt that appears, type 2 to add a
remote server.

5. Atthe Sel ect type of Server (Current: NONE) prompt that appears, type 1 to select library
server.

6. Atthe Sel ect pl at f or mt ype (Current: NONE) prompt that appears, type 3 to select Win-
dows NT.

7. Enter the server name, port number, and host machine address in the sequence and save.

Note: Users can modify the default content/MIME associations in the crbcc2ni me. ini file
located in the EIP root directory (default is C: \ aVBROOT). If the file is changed, it must be
copied to the \ Tenpl at i ngd i ent directory for the updates to be used when the content is
viewed.

Removing EIP

See the Planning and Installing Enterprise Information Portal manual for information on removing Content
Manager from your system.

25
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Installing the Turbo Components

After you have installed Content Manager and EIP, you are ready to install the Turbo Integration
Components.

Installation on the WebSphere Application Server

Before starting the installation, go to Control Panel > System > Environment and set the following
system variables

JAVA_HOME set this environment variable to point to the location of the JDK. It is recommended to
point to the JDK that is available with WebSphere, for example, d: \ webspher e\ appser ver\ j dk.

WAS_HOME  set this to point to the location of the application server directory for WebSphere, for
example, d: \ webspher e\ appser ver .

Installation

As you work through the installation program, the defaults for the required information are displayed
in square brackets [ ] . You can accept the defaults, where appropriate, by pressing Enter. If the
default value is not correct for your system, enter the correct information. You will also need to know
the TeamSite branch and workarea to use for your \Web pages.

Follow these steps to install the TeamSite Integration Components:

1. Ina DOS-prompt window, runi nst al | . bat from the WebSpher e subdirectory of the
installation program directory.

2. Entery to install the WebSphere Application Server component of the Turbo. Refer to the
Interwoven Turbo Product Guide for IBM WebSphere Application Server for more details.

3. Entery to install the EIP component of the Turbo.

4. Enter the path for the appser ver directory for WebSphere; for example,
X:\webspher e\ appserver.

5. Enter the type of searches you want users to perform:
— Fed for EIP federated searches
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— cwmfor directly searching Content Manager (this is the default)

6. Enter the path for the location of EIP (default is X: \ cmbr oot ). This is the home directory where
you installed EIP.

7. Enter the name of the Content Manager library server or accept the default.
8. Enter the user ID for the Content Manager.

9. Enter the password for the Content Manager user ID you just entered.

After you enter this information, the installation program starts copying files for the Turbo
components.

10.When the installation program prompts you whether to continue with the installation of Web-
Sphere Personalization, enter y/ n, depending on your requirements. Refer to the Interwoven Turbo
Product Guide for 1BM WebSphere Personalization.

11.Enter the number of lightweight sandboxes that you want to create.

12.Enter the number of heavyweight sandboxes you want to create.

After the sandboxes are created, they are equipped with the configuration (servlet and classpaths)
required to operate with the Turbo components.

Uninstalling the Integration Components

Ina DOS-prompt window, run uni nst al | . bat from the WebSphere subdirectory of the installation
program directory.

Enter n to uninstall all the components.

Enter y to uninstall the EIP component of the Turbo, then enter the required information as
prompted.

Installation on the TeamSite Server

Before starting the installation, go to Control Panel > System > Environment and set the following
system variables:
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JAVA_HOME set this to point to the location of the JDK (JDK1.2.2 or above).
TS HOVE  set this to point to the TeamSite home directory, usually c: \ i w- horre .

Also, you will need to know the TeamSite branch and workarea your users will use when creating
their Web pages.

Installing the Integration Components
Follow these steps to install the TeamSite Integration Components on the TeamSite server:

1. Ina DOS-prompt window, runi nst al | . bat from the TeamSite subdirectory of the installation
program directory.

2. Entery to install the WebSphere Application Server component of the Turbo. Refer to the
Interwoven Turho Product Guide for IBM WebSphere Application Server for more details..

Enter y to install the EIP component of the Turbo.
Enter the TeamSite installation home, default is c: \ i w- hore.
Enter the host name or IP address of the WWebSphere Application Server.

Enter the port for the WebSphere Application Server or accept the default, which is 80.

N o o &~ W

Enter the TeamSite branch name and workarea you want to use for samples and properties.

After you enter this information, the installation program starts copying files for the Turbo
Components.

When the installation program prompts you whether to continue with the installation of WebSphere
Personalization, enter y/ n, depending on your requirements. Refer to the Interwoven Turbo Product
Guide for IBM WebSphere Personalization.

This completes installation on the TeamSite server.

Uninstalling the Integration Components

In a DOS-prompt window, run uni nst al | . bat from the TeamSite subdirectory of the installation
program directory.

28
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Enter n to uninstall all the components.

Enter y to uninstall the EIP component of the Turbo, then enter the required information as
prompted.

Installation on the TeamSite Templating Client

After you have installed TeamSite Templating Client and the DB2 UDB Client on the TeamSite
Templating client computer, you should install the following components:

« Enterprise Information Portal-Workstation for developers

« Database client support (connection)

« Turbo components

Also, the TeamSite client display must be set to support at least 256 colors

Installing EIP—Workstation
When installing EIP-Workstation, note the following:
 Choose EIP Development Workstation as the type of computer to install.
o Select the following connectors to install:
— Federated
— Content Manager

In the Network Table Generation dialog box, specify the server names, ports and host names for
Content Manager. If your Content Manager is on a remote system, you must supply these values.

You can select the defaults for the other installation options. If you plan to connect to an existing text
search or image search system, enter the information for those systems on the appropriate installation
screens.

If you are using EIP server, you will also want to define the federated entities and attributes for
searching and create the search templates that your Web page authors will use for federated searches.

29
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Removing EIP—Workstation

See the Planning and Installing Enterprise Information Portal manual for information on removing EIP
from your system

Creating a Database Client Connection for the EIP Database

You must have a connection to the EIP database on the client computer if you are going to use
federated searches. Make sure that your DB2 client is configured so that EIP client has access to the
EIP database. Use the DB2 Client Configuration Assistant and the Connection Wizard to configure the
connection.

Select the EIP database and add a connection.

1. From the Client Configuration Assistant window, click the Add button to add a new database.

2. In the next window that opens (the Source tab of the Add Database Wizard), choose the option
Manual | y confi gure a connecti onto adat abase, then click the Next button.

3. This will open the Protocol tab of the Add Database Wizard. Select the TCP/IP button and then
click Next.
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Add Database Wizard — TCP/IP Tab

4. The TCP/IP tab appears.Enter the Host name and Port number (and, optionally, the Service
name) of the DB2 server in the fields provided. Click Next.
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1 Add Database Wizard

1. Source | 2 Protocol | 3 TCPAP. 4 Database | 5.00BC | 6 Nads Options | 7. Security Options |
Step &: Speciy the name of the database to which you want to connect

The database name represents the databass to which you ars connecting, If the database resides on 05/330 o1
HWS/ESA, in the Database name field, type the Location Name. 1 the database resides on 05400, in the
Database nare field, typs the RDE Name.  If the databass resides on YMA/SE, in the Database name field, type
the DENAME. Othenwise, in the Database name field, type the name of the database as it is represented on the
server o which you are connecting, In the Database alias fisld, type & unique local rickname by which you want
10 represent the remole database.  This is the name used by applications on your maching, I the comment fiekd,
you can type your own brief description ta identify the database

Database name |CMEDB]

Database dlias  [CMEDE |

Comment [ J e,
etz
/
<¢Back Finish | Cancel|  Help

Add Database Wizard — Database Tah

5. The Database tab appears.Enter the Database name and Database alias (and, optionally, a com-
ment) of the DB2 server in the fields provided. Click Finish to complete the setup.

After you set up the connection to the EIP database, update the classpath in TeamSite Templating
Client file for the DB2 Client.

1. Openthefiletst. | ax inatext editor such as Notepad.

2. Find the line that defines the lax class path:
| ax. cl ass. path=../Tenpl ati ngC i ent/regex.jar;../ Tenplatingdient/
xerces.jar;../Tenplatingdient/JConfig.zip;../Tenplatingdient/
ExtDirpane.jar;../TenplatingCient/collections.jar;../Tenplatingdient/
swingall.jar;../TenplatingCient;../TenplatingCient/tst45.jar;lax.jar;C/
Program Fi |l es/ I nterwoven/ Tenpl ati ngC i ent/ei pcnl ei pcmjar; C./cnbroot/lib/
cnbod71.jar; C/cnbroot/!lib/cnbviewrl.jar; C./cnbroot/sanpl es/javal/client/
cmbclient7l.jar; C/cnbroot/lib/cnb71.jar; C./cnbroot/lib/cmbsdk71.jar

3. At the end of this line, add the path for db2j ava. zi p; for example, if the DB2 client is installed
on the C: drive, add:

C./Program Fil es/sqllib/javal db2j ava. zi p
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Ensure that you have a semicolon between the last entry in the lax class path and the path you are
adding.

4. Save the file and exit the text editor.

The user id with which the templating client workstation is logged on has to be added to the DB2
users of the database for Federated search (for example, CMBDB) on the DB2 server.

1. Bring up the DB2 control center from the Start > Programs > DB2 .

2. Go to the cvBDB node as shown below.

8 Control Center o=
Control Center  Selected Edit View Tools Help ﬁ@m\.‘:&iﬁ
D EHE S E S8 HE el
D Systems ELEMAKDMNT - DB2 - CMBDB
= m] ELENAKDNT Mame |
-7 Instances [T Tables
B+ DBZ [ views
= D Datahases D Aliases
D RS [:]Tnggers
[j D Schemas
[J oweTRLDE £ Indexes
[j SAMPLE ) DTable Spac...
. D Gateway Connections D connections
5 DB2CTLEY D Replication ...
[:] Replication
D Buffer Poals
[:] Application
% D Userand G..
[:] Federated
P S

DB2 Control Center Window

3. Right-click on cvBDB and a context menu will appear. Select aut hori ti es from that menu. You
will see the Database Authorities dialog box.
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& Contral Center

Caontrol Center  Selected  Edit View Tools Help

% E@Eﬁmmmmmlmmlmm
R Y obose Autbitios MDD~

) systems ELENAKDNT - DE2 - CMBDE
- gl ELENAKDNT

USEI’l araup |

CREATETAB |BINDADD |CONNEZ  Add User.
Grant Al
Revoke All

4 | |
Authorities: DBADM CREATETAB BINDADD
[ves =] [res =] [res =l
CONNECT NOFEMCE IMPLICITSCHEMA LOAD
[ves =] [res =] [res =] [res =l

oK | i S | Al | RESED | Cancel | Help |

4 B 4 T ow I

Database Authorities Dialog Box

5. Click the Add User button.

6. Add the user you want and give the user appropriate permissions by highlighting the added user
and checking on the required permissions.

7. Close all DB2 windows.
Note: After you have created the EIP database client, before it can connect to the EIP database, you
must ensure that the DB2 server’s Authentication Type issetto Ol i ent .

Installing the Turbo Components

Before starting the installation, go to Control Panel > System > Environment and set the following
system variable:

JAVA HOME set this to point to the location of the JDK that comes with EIP: CVBROOT/ j dk/ j r e;
where CVBROOT is the root directory of the EIP installation.

After you have installed EIP, you are ready to install the Turbo components on your TeamSite
Templating client computer.
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Follow these steps to install the Turbo components on the TeamSite Templating Client computer:

1. Ina DOS-prompt window, runi nst al | . bat from the i wei pcl i ent subdirectory of the
installation programs directory.

2. Enter the directory where TeamSite Templating Client is installed or accept the default.
3. Enter the directory where EIP is installed.

4. Enter the type of searches you want your users to perform:
— Fed for EIP federated searches
— cwmfor directly searching Content Manager

This entry must match the types of searches you chose when installing the Turbo components on
the Application server.

5. Enter the name of the EIP database when asked for the server name.
6. Enter the EIP user ID that will be accessing the EIP database.
7. Enter the password for the EIP user ID.

After you enter this information, the installation program starts copying files for the Turbo
components.

When you have successfully installed the Turbo components, you can begin to use TeamSite
Templating to create Data Content Records and preview the Web pages. Chapter 4, “Using This
Product,” provides information on using TeamSite Templating, EIP, and Content Manager to add the
content stored in Content Manager to \Web pages.

Uninstalling the Turbo Components

In a DOS-prompt window, run uni nst al | . bat from the i wei pcl i ent subdirectory of the
installation program directory.

To uninstall EIP components, type in the required information as prompted.
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Setting Up Workareas

After completing the installation of the EIP, Content Manager, and the Turbo components, JSP pages
cannot be previewed unless the workarea (that was specified in the Turbo installation) is connected to
a WebSphere Application Server runtime environment. This is accomplished by allocating a
heavyweight sandbox to the workarea. Users must use heavyweight sandboxes to preview JSPs and
generated HTML page with EIP content reference.

To allocate a heavyweight sandbox to the workarea:

1. Log on to TeamSite and open the TeamSite UI.

2. Go into the workarea that user specified during installation; this should contain a file named
ei p_config.xm .

3. Openei p_config. xm and search for [ cmbr oot ] and replace this string with the actual loca-
tion of the EIP server 1 i b directory (example C: \ cnbr oot \ I i b on the WebSphere Application
Server computer). This config file contains a special servlet named Ret r i eveDoc to handle ren-
dering content from Content Manager through an EIP federated search connector or Content
Manager direct connector. For more information on how to use the confi g. xm file, refer to the
IBM WebSphere V3.5 Handhook or the Interwoven Turbo Product Guide for IBM WebSphere Application
Server.

4. Select File>Sandbox Pool. A sandbox selection form will be displayed.

5. Choose the heavyweight sandbox and specify the ei p_confi g. xml and fill in the servlet classpath
that contains any other servlet that will be used within your workarea.

6. Click Check Out. If successful, a status page will be displayed; if not, a status page with a specific
error will be displayed.

Heavyweight sandbox users can develop their own conf i g. xm to include other properties to
configure their Web application. But the Ret r ei eveDoc and the Aut o- | nvoker Servlets are
required to be part of the Web application. Without the Aut o- | nvoker , the Ret ri eveDoc servlet
will not be able to call other servlets because these servlets are not registered with the Web
application. For details how to construct config.xml, refer to IBM WebSphere V3.5 Handbook. Here is
the XML to set up the Aut o- I nvoker and Ret ri eveDoc servlets:

36

Interwoven Turbo Product Guide



<servl et nane="RetrieveDoc" action="create">
<descri pti on>Retri eveDoc</ descri pti on>
<code>Ret ri eveDoc</ code>
<init-paraneters>
<par anmet er nanme="propFil ePat h" val ue="[cnbroot]"/>
</init-parneters>
<l oad- at - st art up>true</ | oad- at - st art up>
<debug- node>f al se</ debug- node>
<uri - pat hs>
<uri value="/RetrieveDoc"/>
</ uri - pat hs>
<enabl ed>t r ue</ enabl ed>
</servl et>

<servl et name="Auto-I|nvoker" action="create">

<descri pti on>Aut o- Generated - Serves Servlets by d assnane</description>
<code>com i bm ser vl et. engi ne. webapp. | nvoker Ser vl et </ code>

<init-parameters/>

<l oad- at - st art up>true</ | oad- at - st art up>

<debug- node>f al se</ debug- node>

<uri - pat hs>

<uri value="/servlet"/>

</ uri - pat hs>

<enabl ed>t r ue</ enabl ed>

</servlet>
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Chapter4

Using This Product

This chapter outlines how to use the Interwoven Turbo for EIP and Content Manager. It describes
creating data content records (DCRs), generating and previewing DCRs using different presentation
templates (PT), and customization. The Turbo installation copies four sample presentation templates
(pr 1, pr2, pr 3, and pr 4) into the presentation subdirectory of the workarea specified during
installation. The use of these PTs is also covered in this chapter.

Creating a DCR

The Turbo product can be used to create data content records (DCRs) by executing the following
steps:

1. Log on to the TeamSite server and go into the workarea specified during the Turbo installation.

2. From the File Menu, select the New Dat a Recor d option. In the window that appears, select
ei pcnsear ch.

3. Then in the next window, choose pr and click the Select button. This will bring up the data cap-
ture template to enter data. Fill the form with relevant data. This form includes the Text Item and
Image Item fields with Search buttons attached. These fields allow you to search EIP or Content
Manager and bring the reference of the selected item back to the DCR.
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TeamSite Templating Data Capture Form

4. Clicking on the Search button for Text Item Field will launch an external Java application for EIP
and Content Manager, the Enterprise Portal Client Search Window, which allows you to search for
any text document item by specifying the search criteria. It is assumed that users will select the
appropriate type of text document for content retrieval depending on how they plan to use this
text document item (constraints applied to use with different PTs).
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4% Enterpiise Portal Client Application

o wBE F 5 @

MISAMPLE | | WWEAMPLE [MEG = e
TEST subjest  [EQUAL =
TEXT confent  [EQUAL =i
Date [EquaL =1
language [EQUAL =l
“3Seann Resuts || IWSAWPLE |
Authar Subjsct | Content Typs Date | Languags
J_E.E.Baglin_[Thin film bonding._|gif Image 1-01-| |English =
R.Evernden  |The Information F... aif Image -11-! English =
D. Pri |Autornated subpL... gif Image 11 English
M. Hoski.. The four-paramet... gif Image 02 English
R.M. Hoski... The four-paramet. .. gif Image 02 English
C. MeCready|Reade of [BM J... |html Document |2 EnglishTranditio
B. Present |ReadMe of IBM ... |htm| Document 2 EnglishKorean
(B wchiut Background data .. gif Image 1 English
1. Shub [The implicit functi... aif Image 1 English
R. A Nobakht _|A unified table-ba.. gif Image 1896-11- English
C. M. Saracco |Lotus Ward Pro ... ‘TEXIDDCUMEH( -05-11 English
R.Evernden  [The F..|gif Image -11-08 English
B.L. Bradiord_[The Fast Stagger...if Image -01-02 English =

203 items found. Search completed.

Enterprise Portal Client—Search Window

5. Click the Search (flashlight) icon, then, from the search results window you can select one item by
highlighting that item and pressing the Select icon on the toolbar.

6. You will get a confirmation message box saying that the reference of the selected item has been
sent. Now, close the EIP and Content Manager interface. Repeat the steps outlined above to select
a reference for the Image item.

7. You can now save the DCR by giving a name and clicking on the Save button. The DCR is saved
under the given name in the dat a subdirectory.

bagil - Enterprise Portal Client Application o] x]|

B o -l Fin
=iy g 5 e
— WSAMPLE | | mwSAMPLE [NEG =l
TEST subject  [EQLAL =
TEXT content  [EQUAL B3|
Date [Equal B3|
language |EGUAL L”
18 h Resul:
e B B F rtcrprie Portal Client x
Authar QUAGE
J.E.E. Bag -
R. Evernde The item id of the selected row has been sent. [l
M. D. Pritt
JoR.M Hot
J. R M. Hog
S. C. e - ITranditio..
. B. Present  |ReadMe of IBM J... |himl Document 10 Englishkorean
B. WeMutt Background data ... gif Image 04 Englis
. Shub The implicit functi... @if Image -04 Englis
. A MNobakht |Aunified table-ha.. pif Image -15 Englis
I . Saracco |Lotus Word Pro .. Text Document 1 English

R.Evernden  |The Infarmation F 1994-11-08
[]B.L Bradford |The Fast Stagger.. |gif Image |1988-01-02 [English !j
| ani. lmmrmrana o warecosisiliennanan e

Search Results Window with Confirmation Message Box
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Generating or Previewing DCRs with Presentation Templates

DCRs can be previewed or associated with an output page using the Gener at e Page option from the
File drop down menu in the TeamSite GUI, which brings up the Generate/Preview File window with
a list of the data categories specified in the t enpl at i ng. cf g file. Turbo installation sets up one data
category called ei pcnsear ch and one datatype called pr. Double-click on the data category name
ei pcnsear ch. Then select pr from the next Generate/Preview File Window that opens.

Data Content Recaord I_\Je\pnmseamh hd Presentation Template

Hame: Size Type Moifisd |
EN E1KB TPL-file 0412701 04:48 PM
2 pr2tpl 926 TPL-file 04112701 04:48 PM
2 pratpl 1AKB TPL-file 04112701 04:48 PM
2 pragpl 1AKB TPL-file 04112701 04:48 PM

04713/01 0213 P

FrEviE) BRrerate Close

Generate/Preview File Window

Next, the DCR and Presentation Template Selection Window will open and display the DCRs under
this data type. Select the DCR you want to preview from the left pane and select the PT you want the
DCR to be previewed against and then click the Preview button. This will bring up a new browser
with the contents of your DCR and the item selected from EIP and Content Manager displayed
according to the PT you selected.
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TRL-file 04412101 04:48 PM
TRLfle 04412701 04:48 PM
TRL-fle 042001 04:43 PM

Data Content Record |J pr LI _I Presantation Template
Hame Size Typs Mosified Hame Size Type Mosifiect
773 fi 04416101 Bl to 1KE Tl
2 markone 790 fie wna0n 1103 A |2 praspl a2
) muipriz 729 fie 04A1301 0412 P S 11KB
12 Mutiniorkareagl T file 04716101 03:32 P 2 pratpl 11k8
3 pritewTest 32 fle 04413001 04:02 Fh
2 RickyFourFed 669 file D4416101 11:07 AM
) Rickyone B57  file 04413101 0305 M
) RickyoneFed 894 file 04416101 10:52 AM
2 Rickypriz 663 fle 04413001 0345 Fh
D Rokyprie 675 fie 04113001 03:39 P
2 RickyThresFed 676 file D4416I01 11:02 AM
3 RickyTwo 732 file 04413101 03:46 P
2 RickyTwoFed 58 fle 044601 1057 At
3 Ricky TwonutFed 784 fle Q4HBIT 1111 At
) videopri2 662 file 04413001 04:08 PM
Preview | Generate ... | Close

DCR and Presentation Template Selection Window

Preview Window

A sample preview will be displayed.

= . » . © ‘ = ‘ . »
Back Foa Siop h Hame Seach  Fawoiles Histo Wai Pint Edit Discuss
Address [&] ATy t_name=/kk T8ptName=prl tpltiv_ ¥ o X ~| 6o
< EY-IE (searon [-]| cueet Toowar @My Vahoo! ~ <iNews - 7 Entertaimert ~ (lSpots - () Shopping v i Finance - wevYaho! >
SRR e 7ot
home === SUNNYVALE, Calif.
point of view ==
products =1 L
customers =1
partners com Text Retrieved from EIP/CM Lotus Word Pro Release @ Readme wri This file
company Com contains important information that 1s not included m the printed documentation or
mvestors Comm online Help. This file contains information on the following topics: » Support
news == Information > New Features > Corrections and Additions to Online Help > Tips and
press Tricks for Using Word Pro > Macro and Seript Information Support Information
coverage >Telephone numbers For all PC desktop products, call Customer Service: 1-800-
awards 343-5414, or Techical Support for all Windows Desktop applications: 1-578-988-
events 2500. The hours are Monday - Friday, 8:00 am. - 2:00 p m (Eastern time). >Lotus
services =1 Customer Support You can access all available customer support numbers in your
library == country by Following the instructions below. 1. In Word Pro, choose Help - Help
careers o Tepics 2. Click the Contents tab. 3. Double-click the Troubleshooting Help topic
feedback oo 4. Double-click the Lotus Customer Support Help topic. 3. Double-click the desired
country. 6. Click the desired topic. »Suppert from CompuServe IFyou subscribe to
CompuServe, you can download updated LomsScript Help and other information.
In CompuServe, visit the Word Pro forum (type "GO WORDPRO"). >Support on
the Internet IF you have an Internet connection, you can dewnload updated
LotusSeript Help and other information from the Lotus Support Web page. To
access the Lotus Web page, your computer should have a WinSock-based
connection to the Internet. Follow the directions provided with your browser for
downloading files. The Web site is located at:
hitp: support lotus pipubdesltop! Tou can access the same
&1 Dane mEETE
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Note: The sample data that comes with EIP and Content Manager has four different data types—
text, HTML, GIF and MPEG. These could be single-part content and multi part content. The
type of data selected is important while previewing them using appropriate sample
presentation templates. For example, pr 1 can be used to preview only single-part text
documents whereas pr 2 can be used to preview any type of document. Pr 3 and pr 4
demonstrate the ability to generate JSP pages; pr 3 demonstrates a federated search and pr 4
demonstrates a Content Manager direct search. Pr 3 and pr 4 can only support single-part text
documents.
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Customization

Customizing DCTs

Data Capture

When users enter and save data through TeamSite Templating using a data capture template (DCT),
the data is stored as XML and later used to fill in presentation templates to generate multiple
renderings of the content. Users can enter data in the TeamSite Templating GUI by selecting and
filling in a form generated from a DCT. When the captured data is saved, it is stored as a data content
record (DCR) in the TeamSite file system.

Compare the form with the XML file containing the DCT file above. Each item tag in the DCT
corresponds to a field in the form; for example, the first item tag Publish Date is the label for the first
field in the form. The other items under each tag define the description for the field, database data
type, type of the field, and the validation regular expression.

TeamSite Templating organizes data based on category and type. Data category is at the top level of
data organizing hierarchy. Each data category contains one or more specific data types. For example,
data category beverages might contain data types coffee, tea and so on.

The data storage hierarchy is shown in the following diagram:

templatedata

‘dai‘a_caregory_ i‘ ‘dafa_category_? ‘ N

| data_type_1 ‘ | dam_}ype_2|
‘ data | |presemaiion |
content_| J’ecord_i' pres_template_1.tpl

content_record_2 pres_template_2.tpl

Data Storage Hierarchy
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TeamSite Data Structure Hierarchy

A sample template is shipped with Interwoven Turbo 2.0 for EIP and Content Manager. This sample
contains a data type, Pr ess Rel ease (pr) under the category ei pcrsear ch. You can see the data
capture template associated with this data type in the file named dat acapt ur e. cf g in the directory
t enpl at edat a\ ei pcnsear ch\ pr. The dat acapt ur e. cf g file that is imported by the Turbo

Installation into the workarea looks like:
<?xm version="1.0" standal one="no"?>
<! DOCTYPE dat acapt ure SYSTEM "dat acapture4.5.dtd">

<dat a- capture-requi rements type="content" nane="pr">
<l-- data-capture-requirenents elenments contain area el enents -->
<rul eset name="Press Rel ease">
<descri pti on>
Enter Press Rel ease information.
</ descri ption>
<l-- file elenents contain itemel enents -->

<i tem nane="Publ i sh Date">

<description>date format is YYYY- MM DD</description>
<dat abase dat a-type="DATE" dat a-formt="yyyy- Mt dd" />

<text required="t" maxl ength="10"

val i dation-regex=""[0-9][0-9][0-9][0-9]-[0-1]

[0-9]-[0-3][0-9]%" />
</litenpr

<i t em name="Headl i ne" >
<dat abase dat a-type="VARCHAR(100)" />
<text required="t" maxl engt h="100" />
<litenp

<i tem name="Secondary Headl i ne">

<dat abase searchabl e="f" dat a-type="VARCHAR(200)" />

<t ext maxl| engt h="200" />
<litenp

<i tem name="I| ntroductory Paragraph">
<dat abase depl oy-col um="f" />
<textarea rtf="t">
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</t ext ar ea>
</litenr

<i tem name="Story">
<dat abase depl oy-col um="f" />
<replicant nmax="4">
<i t em name="Subheadi ng" >
<t ext maxl engt h="100" />
<litenp
<i t em name="Secti on Paragraphs">
<replicant max="4">
<i t em name=" Par agr aphs" >
<textarea required="t"/>

<litenp
</replicant>
<litenp
</replicant>

<litenp

<i t em name=" Aut hor " >
<dat abase dat a-type="VARCHAR(40)" />
<t ext maxl engt h="40" />

<litenp

<i tem nane="EMai | ">
<dat abase dat a-t ype="VARCHAR(60)" />
<t ext maxl| engt h="60" />
</litenr
<i tem nane="Text|tenl >
<descri pti on>
Ht Search to invoke the EIP Search Panel. Then sel ect
atext-itemfromthe Search Results
</ description>

<t ext >
<cal l out type='java-class' |abel="Search!"’
| ocation="http://local host/iw java-call out-api/exanpl es/'
cl ass='com i nt erwoven. dc100. api . El PCal | out' />
</text>
<litenmp
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<i t em name="1|magel t eni >

<descri pti on>

Ht Search to invoke the EIP Search Panel. Then sel ect an
i mge-itemfromthe Search Results
</ descri ption>

<t ext >

<cal | out type='java-class' |abel = Search!
| ocation="http://1ocal host/iw java-call out-api/exanpl es/'
cl ass=' com i nt erwoven. dc100. api . El PCal | out' />

</text>
</litenpr

<i t em name="Language" >
<dat abase dat a-type="VARCHAR(10)" />

<r adi 0>
<opti
<opti
<opti
<opti
<opti
<opti
<opti

</radi o>

</itenp

</rul eset >

on
on
on
on
on
on
on

| abel =" Engl i sh" val ue="English" />

| abel =" Ger man" val ue="Ger man" />

| abel =" French" val ue="French" />

| abel =" Japanese" val ue="Japanese" />
| abel =" Chi nese" val ue="Chi nese" />

| abel =" Spani sh" val ue="Spani sh" />

| abel ="Italian" value="Italian" />

</ dat a- capt ure-requi renent s>

For more information on using TeamSite Templating, see the TeamSite Templating User’s Guide.

Search Application

From within the TeamSite Templating data capture template, click the Search button to open the
Enterprise Portal Client Search window. In the Enterprise Portal Client search window, users enter
the criteria for their search and click on the flashlight icon to start searching content that matches their
criteria. The search results are displayed in the Search Results window.
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Claim Author [nEQ =k
DLSAMPLE | Subject  [EQUAL =
IWSAMPLE ContentType [EQUAL =i
NOINDEX Date [EquaL =
Language |EGUAL LI |
4 Search Results IWSAMFLE'
Author Subject ContentType Date Language
J. E. E. Baglin hin film banding using ion b... |gif Image 1-01-0. 5 A|
R. Evernden he Infarmation Frameiork  |pif Image -11-0! 5
J. R M. Hosking he four-parameter kappa di.. |oif Image -02-2. 5
J. R M. Hosking he four-parameter kappa di.. |oif Image -02-2. 5
5. C. McCready eadMe of [BM JDK Install htrnl Document 2000-03-1 ishTranditional Chinese
M. B. Present Readie of IBM JDK Install hirnl Docurnent F03-1 Korean
B. McMutt Background data movernenti... |oif Image -10-0! 5
R. A Nobakht A unified table-based Viterbi .. |oifImage -11-1 5
C. M. Saracco Lotus Word Pro Release 9 R... [Text Docurment -05-1 El
R. Evernden The Information Framewvark  |oif Image -11-0! 5
B. L Bradiord The Fast Staggered Transfor... |gif Image -01-0: 5
J.H. Hedges ODPTF2.2.1.3 Readme Test Docurnent -10- 5
M. B. Present Readhie of IBM JDK Install hirnl Docurnent 2000-03- Korean
C.H. Andetson Readhie of IBM JDK Install hirnl Docurnent 2000-03- El
C. M. Saracco Lotus Ward Pro Release 8 R... [Texd Docurment 1998-05- El
M. 8. Cox Readhie of IBM JDK Install hirnl Docurnent 2000-03- ishFrench
. Durig Atamic-scale metal adhesion... |oif Image 1993-06- 5
D. J. Archar Readie of IBM JDK Install hirnl Docurnent 2000-03-1 El
T. Ohta Use of multiple representatio. . |gif Image 1954-07-0. 5
. D. Thouless Fracture mechanics far thin-fl.. [gif Image 1954-10-0 5
R.T. Goulde Readie of IBM JDK Install htrnl Document 2000-03-1 ishParuguese
F.J. Taylar Readie of IBM JDK Install htrnl Document 2000-03-1 ishDanish
L] D. Coppersmith The Data Encryption Standar... |gif Image 1954-10-0 5
L] IBM IBM Sofware Development Fa... Video Clip 2001-02-3 5
A.B. Hodel Readie of IBM JDK Install hirnl Docurnent 2000-03-1 shChinese
T. Ohta Use of multiple representatio. . |gif Image 1954-07-0. 5
F.Gozo Recursive leastsguares sed.. |pif Image 1954-12-0. 5
P F.Freeman QD PTF2.21.6 Readme Text Docurnent 2000-04-0 El
Charles J. Bantempo ﬁM enetwork Personal Com.. [Text Document 1998-06-1 5 j
188 items found. Search completed.

Search Results Window

Search Results

When the search results are returned, highlight an item, then click the Select button on the toolbar to
bring a reference of the selected item to the templating environment and save it as part of the DCR.

The key items retrieving content from EIP and Content Manager are the last two fields in this DCT,
Text | temand | mage | t em These fields make use of the Java call-out facility in templating to
launch an EIP search GUI that displays an EIP search panel to search in Content Manager. After
running the search, selecting a particular item of interest places a reference to that content item to the
DCR. The information regarding the callout, such as the type of callout, location, and such, is
specified in the callout tag. Use the dat acapt ur e. cf g file from the Press Release sample when
creating your own templates. Depending on your requirements the whole DCR form can be
customized including the number of callout buttons required.
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For more details on how to create dat acapt ur e. cf g, see the TeamSite Templating Classic Developer’s
Guide.

Customizing Presentation Templates
In addition to customizing the data capture, the presentation template can be customized as well.

After data is captured and stored as a data content record (DCR), you can combine the DCR with a
presentation template. The result is a generated output file that displays the content in a way defined
by the presentation template. The same DCR can be used to generate multiple output files using
different presentation templates. The resulting pages contain the same content but displayed in
different formats according to the associated presentation templates.

The Press Release sample shipped with the Interwoven Turbo for EIP and Content Manager contains
four presentation templates: pr 1, pr 2, pr 3, and pr 4. These templates demonstrate the capabilities
of the presentation templating mechanism. The sample templates are available in the directory

t enpl at edat a\ ei pcnsear ch\ pr\ presentati on.

Presentation Template 1 (Pr1)
Pr 1 is listed below. PTs are XML files that can contain HTML, Interwoven tags, and Perl code.

<?xm version="1.0" encodi ng="UTF-8"?>
<i w_pt nane="PressRel ease" ><! [ CDATA|
<HTM_>
<l-- Begin CDATA Tag -->
<l-- HTM. stuff is enclosed in CDATA tag -->

<HEAD>
<META HTTP- EQUI V=" Cont ent - Type" CONTENT="text/htm ; charset=UTF-8">
</ HEAD>
<body bgcol or =" #FFFFFF" | i nk="#0033CC"' vl i nk="#0033CC"' al i nk="0000FF"
TEXT=#000000 BACKGROUND="/t enpl at edat a/ ei pcnsear ch/ pr/i nages/
pi xel . gi f">
<TABLE W DTH="720" VALI GN="top" CELLPADDI NG="0" CELLSPACI NG="0"
BORDER="0" >
<TR><TD W DTH="200" VALI G\="TOP" >

50 Interwoven Turbo Product Guide



<I M5 SRC="/tenpl at edat a/ ei pcnsear ch/ pr/i nmages/i w | ogo-snall.gif"
W DTH="220" HEl GHT="40" BORDER="0"/>

11> <!-- End of CDATA Tag -->

<p>
<iw_include file="tenpl at edat a/ ei pcrsear ch/ pr/iwprnavbar. htm"' />
<BR></ BR> </ P>

<I[ CDATA] <!-- Begin CDATA Tag -->
</ TD><TD VALI GN="t op" W DTH="510">

11> <!'-- End of CDATA Tag -->
<i w_perl >
<! [ CDATA
sub get _image_id
{
use URI:: Escape;
ny $item D = i wpt _dcr_val ue(' dcr. | mageltem);
return (uri_escape($item D));
}
sub get _text_id
{
use URI:: Escape;
ny $item D = i wpt _dcr_val ue(' dcr. Textltem);
return (uri_escape($item D));

}

sub get _was_server

{

use TeanSite:: Config;

$iw_home = TeanSite:: Config::iwgethome();

ny $prop= "$i w_home\\l ocal \\config\\iweip.properties";
open( PROP, "$prop") or die "Could nt open $prop \n";
whi | e( <PROP>)

{

ny $line = $_;

if ($line =~ /SERVER=(.*)/){ $wasserver = $1;}
}

return ($wasserver);

}
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sub get_was_port

{

use TeanSite:: Confi g;

$i w_hone = TeanSite:: Config::iwgethone();

ny $prop= "$i w home\\l ocal \\config\\iweip.properties";
open(PROP, "$prop") or die "Could nt open $prop \n";
whi | e( <PROP>)

{

ny $line = $_;

if ($line =~ /PORT=(.*)/){ $wasport = $1;}
}

return ($wasport);

}

sub get_web_app

{

use TeanSite:: Confi g;

$i w_hone = TeanSite:: Config::iwgethone();

ny $prop= "$i w_home\\l ocal \\config\\iweip.properties";
open(PROP, "$prop") or die "Could nt open $prop \n";
whi | e( <PROP>)

{

ny $line = $_;

if ($line =~ /WEBAPP=(.*)/){ $webapp = $1;}

}

return ($webapp);

}

sub cal | _servl et
{
use HTTP:: Request:: Conmon gqw POST) ;
use LWP:: User Agent;
ny $itemd = $ [0];
ny $wasserver = get_was_server();
ny $wasport = get_was_port();
nmy $webapp = get_web_app();
ny $url = "http://" . $wasserver . ":" . $wasport . "/" . $webapp . "/
Retri eveDoc" ;
ny $ua = LWP: : User Agent - >new() ;

ny $req = POST($url, [ itemid => $itenmid ] );
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ny $f or_debug = $req->as_string();
ny $res = $ua->request ($req);

if ($res->is _success()) {
ny $resulting _doc = $res->content();
return $resul ting_doc;

}

el se

{
return "\nHTTP Request Failed.\n"

}

11>

</iw_perl>

<l-- Begin content area -->

<l-- Headline -->
<H2> <i w_val ue name='dcr. Headl i ne' / ></ H2>

<p></ P>
<br></ br >

<l-- Secondary Headline -->

<h3> <i w_val ue name='dcr. Secondary Headline'/> </ h3>

<l-- Date -->
<P> <B>SUNNYVALE, Calif., <iw value name='dcr.Date'/>:</B></P>

<l-- Introductory Paragraph -->
<P><i w_val ue nanme='dcr.|ntroductory Paragraph' /> </ P>

53



o

‘m» INTERWOVEN

~

<l-- Story -->
<iw.iterate list="dcr.Story' var=story'>

<l-- Subheading -->
<i w_val ue nane='story. Subheadi ng' />

<l-- Paragraphs -->

<iwiterate |list="story. Section Paragraphs' var='para_val ue' >
<p><p><i w_val ue name=' para_val ue. Par agr aphs' / ></ p></ p>

</iw.iterate>

</iw.iterate>
<p><B> Text Retrieved from El P/ CM </ B>
<i w_perl >
ny $item = iwpt_dcr_value(' dcr. Textltent);
ny $content = call_servliet($item;
i wpt _out put ($content) ;
</iw_perl>

</ p>
<l-- Insert '"aboutIWhtm"' file -->
<p>
<iw_include file="tenpl at edat a/ ei pcnsear ch/ pr/ about I Whtm "' />
</ p>

<p>For nore information on the conpany and
its software solutions, visit the Interwven Wb site at
<a href="http://ww.interwoven. com >ww. i nt erwoven. conx/ a>
or email <a href="milto:{iw value name="dcr.EMail"'}">

<i w_val ue nanme='dcr.EMail"'/></a>
</ p>

<l-- HTM. stuff is enclosed in CDATA tag -->
<! [ CDATA| <l-- Begin CDATA tag -->

<p>
<TABLE W DTH=520 BORDER=0 CELLSPACI NG=10 CELLPADDI NG=0>
<TR>

<TD COLSPAN=2 BGCOLOR=#999999>
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<I M5 SRC="/tenpl at edat a/ ei pcnsear ch/ pr/i mages/ pi xel . gi f">
</ TD>
</ TR>
<TR>
<TD COLSPAN=2> <BR>
<!-- Begin question -->
<CENTER>
<FONT S| ZE=3><B>
<A HREF="/cust omer s/ profil es/ bestbuy. htm ">How i s Best Buy pushing
billions of dollars in business towards the Web?</A>
</ B></ FONT>
</ CENTER>

<l-- End question -->
</ TD>
</ TR>
<TR>
<TD COLSPAN=2>&nbsp;
</ TD>
</ TR>
<TR>
<TD COLSPAN=2 BGCOLCOR=#999999>
<I M5 SRC="/tenpl at edat a/ ei pcnsear ch/ pr/i mages/ pi xel . gi f">
</ TD>
</ TR>
<TR>
<TD W DTH=250 VALI G\="t op" ><I MG SRC="/t enpl at edat a/ ei pcrsear ch/ pr/
i mages/ pi xel . gi f" WDITH=250 HEl GHT=1>
<FONT SI ZE="1" COLOR=#666666> <B>d obal Headquart er s</ B><BR>
I nt erwoven, | nc.<BR> 1195 W Frenont Ave. #2000<BR>
Sunnyval e, CA 94087 US<BR> Phone: (408) 774-2000<BR>
</ FONT>
</ TD>
<TD W DTH="250" VALI GN="t op" ><BR><FONT Sl ZE=1 COLOR=#666666>
<B>How Can W& Serve You?</B><BR>
Let us know at: <A HREF="mail t o:i nf o@ nt erwoven. cont >
i nf o@ nt er woven. conk/ A><BR>
or <A HREF="/cgi-bin/reg">Register</A> and we will contact
you! <BR>
<BR><NOBR>Wb Team <A HREF="nmi |t o: webt eam@ nt er woven. cont' >
webt eam@ nt er woven. conx/ A>
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</ NOBR></ FONT>
</ TD>
</ TR>
<TR>
<TD COLSPAN=2 AL| GN=CENTER> <BR>
<FONT COLOR=#666666> <P CLASS="copyright">
<A HREF="/copyright.htm "> Copyright &copy, 1999</A>
Interwoven, Inc. Al rights reserved. </ P> </ FONT>
</ TD>
</ TR>
</ TABLE>
</ TD>
</ TR>
</ TABLE>
</ BODY>
</ HTM_>
11> <l-- End CDATA tag -->

</iw_pt>

The Perl functions included in this presentation template are used to retrieve the text document
content by item ID and embed the actual content into an HTML file during page generation process.
The i wei p. properti es file stored ini w- hone\ | ocal \ confi g directory contains information
about the WehSphere Application Server, the port, and the Web application that will be used by the
Perl functions to issue HTTP POST requests to contact the Ret r i eveDoc servlet that is registered
with a specified Web application within WebSphere Application Server. The Perl functions

get _was_server (), get_was_port (), andget _web_app() within the presentation template
return the server name, server port, and Web application name respectively from the above property
files. The function cal | _servl et () uses the functions mentioned previously to construct a URL
and issue an HTTP POST request to the Ret ri eveDoc servlet. In this example, only a single-part text
document that contains plain text can be used with this presentation template to generate a static
HTML embedding the actual text content. The Ret ri eveDoc servlet retrieves the content by the
item ID through EIP API functions. The sample output using the presentation template pr 1 is shown
below:
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rosoft Internet Expl

- . i - =
Back. e Stop  Refiesh  Home Search Favortes  History Mail Edit Discuss
Address [&] _nane=/Fed 1. tpiin_ ¥ DRKAREA /b =] @G0 || Liks >

home ==
point of view ===
procucts ===
customers o
partners ==
company =
investors ==,
news
press
coverage
awards
events
services o
library ===
careers =
feedback ==

SUNNYVALE, Calif., :
single part

Text Rewrieved from ETP/CM

* IBM elletwork Personal Communications ¥4.20 * * for Windows 95 and
Windows IT * * * * Read Me - Please | * * (README TXT) *

First Edition -—----------- This document contains information supplementary to the
cnline Help and the Publications; it includes such things as newly-added function,
hints, tips, restrictions and corrections. For on installing Personal
Communications, please refer to the online Help for the INSTALL program. Thank.
you for choosing Personal C ications V4.21 Contents

* IBM Personal Communications Internet Home Page * Installation problems with
IS NT V3.51 Service Pack 4 and M3 NT V4.0 * New "Use first available LA

]

adapter’ option * New defaults for 5250 sessions * Telnet 5250 Session Hang when
Using TPXJSPX Sockets * Installation problems on machines with TBM AntiVirus

Program * Trace Utlhty coesistence problem on Comn Server/NTT V5.0 machines *

Custornize MacrofScript panel is too wide for soreen on 1T 3.51 * Last mimute

changes to WINITOF H fle * New VEScript asECLPS method WaitLong delay)

* Invalid method error when vsing GetWindowRect method * DBCS IME auto-

start hidden switch (DBCS only) * Unable to open Microsoft Excel 97 files created

using Data Base Access * MS Excel, Lotus 123 and Lotus Approach DataBase

data source problems * Database Access incompatibility with Lotus 1-2-3 for

Smartsvite 97 * How to get Lotus Approach improved ODBC and SQL support * -
. e KT mee 15 "

Mool Aok P,

R S "

&1 Done [}
Preview Window Generated by Presentation Template 1 (prl)

Presentation Template 2 (Pr2)
The following presentation template is the pr 2 sample.

<?xm version="1.0" encodi nhg="UTF-8""?>
<i w_pt nane = "PressRel ease3">

<l-- HTM. stuff is enclosed in CDATA tag -->
<![ CDATA[ <!-- Begin CDATA tag -->
<HTM_>
<head>
<title>Test Inmage Retrieve</title>
<body>
11>
<i w_perl >
<! [ CDATA[
sub get _imge_id
{
use URI:: Escape;
ny $item D = iwpt_dcr_val ue(' dcr. | mageltem);
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return (uri_escape($item D));

}
sub get _text_id

{

use URI:: Escape;
ny $item D = i wpt _dcr _val ue(' dcr. Textltem);
return (uri_escape($item D));

}

11>

</iw_perl>

<p><b> This is the Inage Retrieved from CM Di rect </b></p>
<! [ CDATA[ <I MG SRC="/
Retri eveDoc?i tem d=]] ><i w_per| > wpt _out put (get _i mage_id()); </
iw_perl><![CDATA["/>]]>

<p><b> This is the Text Content Retrieved from CM Direct </b></p>
<! [ CDATA[ <a href="/
Retri eveDoc?i tem d=]] ><i w_per| > wpt _out put (get _text _id()); </
i w_perl ><![ CDATA[">Cl i ck here</a>

</ body>
</ HTM.>

11>

</iw_pt>

This presentation template illustrates the use of HTML <I MG SRC> and <A HREF> tags in conjunction
with the Ret r i eveDoc servlet to retrieve the text item and image item, as an alternative method for
retrieving the content. This presentation template can support multi-part document items as well as
single-part document items.

This presentation template, unlike pr 1, generates a JSP page with an <I MG SRC ..> reference to the
image content and an <A HREF ..> URL reference to the other content. These links can be a
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reference to multi-part content as well. The multi-part content can be displayed by the
vi ewf ranes. j sp file, which is used by the Ret r ei veDoc servlet.

The vi ewf r ames. j sp file, other associated JSP files, and supporting files are copied into the i wei p
directory of the workarea specified during Turbo Installation. Users can customize the

vi ewf r anes. j sp file and any related JSP file provided that they do not change the file name and the
structure of the i wei p directory in the workarea. For more information on how to customize the
servlet and JSPs to handle multi-part documents, refer to the “Customizing the RetrieveDoc Servlet”
section at the end of this chapter.

The servlet classpath of the Web application that contains the Ret r ei veDoc servlet should have all
the EIP-required JAR files: for example, cnb71. j ar, cmbsdk71. j ar and cnbvi ew71. j ar.
Usually, these three JAR files are available in the root installation of EIP, for example, in
c:\cnbroot\lib.

When this presentation template displays an image it appears like the following:

This is the Text Content Retreived from CM Direct

Click: here. :
o [ (% Losaliniranet

Preview Window Generated by Presentation Template 2 (pr2)
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Presentation Template 3 (Pr3)

Presentation template pr 3 illustrates the use of JSP with EIP API functions to perform federated
searching in retrieving the content. This sample PT demonstrates that it is possible to generate a
complete JSP file. The code implements direct EIP Java API calls to retrieve the content rather than
using the servlet and the output is written to the output stream as String. The JSP generated by this
sample presentation template can handle only single-part text contents. The JSP can be modified to
handle other types of contents. The template is listed below:

<?xm version="1.0" encodi ng="UTF-8""?>
<iw_pt name = "PressRel ease3">

<l-- HTM. stuff is enclosed in CDATA tag -->
<! [ CDATA[<!-- Begin CDATA tag -->
<HTM_>
<P> <b> Text Retrieved from Fed using APls </b> </p>
<p>
<%@ page
| anguage="j ava"
i mport="java.util.*, comibmnm beans.*, java.io.*"

%>
<%
CMBConnecti on connBean = nul | ;
CMBConnect i onPool cnPool Bean = nul | ;
String itemid = "]]><iw_val ue name="dcr. Text|tem /><![ CDATA[ ";
CMBltemitem = new CMBlIten(itenid);

cmPool Bean = new CMBConnecti onPool ();

cnmPool Bean. set DsType(" Fed");

cnmPool Bean. set MaxFr eeConnecti ons(100);

cnPool Bean. set MaxFr eeConnect i onsPer Useri d(100) ;

connBean = cnPool Bean. get Connecti on("cnbdb", " cnbadmi n", "password");
CvBDat aManagenent dat aBean = connBean. get Dat aManagenent () ;
dat aBean. set Dat ahj ect (iten);
dat aBean.retrieveltem);
CMBObj ect content = dat aBean. get Content (0);
String m nmeType = content.getM meType();
response. set Cont ent Type(ni neType);
%
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</ p>

<p> <% out.wite(new String(content.getbData())); % </p>
</ HTML>
11>

</iw_pt>

Using pr 3 to display text content would look like the following:

iw-mount/default/main/BuildT esting WORKAREA/wa2/templatedata/iw_preview - Microsoft Internet Ex)

Edt View Favoies ook Hep

- = (6]

Q ] = = = 7
Back | ol Ston Rehtesh Home ‘ Seach  Favoiles  Histoy ‘ Mai Fin! Eil] Discuss
Address [&] _name=/Micky T hreeF ckyThieet toltin_ ¥ eslingwWORKAREAAwaZtin_server-skainintns | Go

N ﬁa‘ﬂ [searcn[-]| GuestTw\bar.

&My Yahoo! ~ <7FNews ~ ¥ Entertainment - (iSports ~ (7) Shopping ~ uyd Finance ~ s+ Yahoo! »

Text Retreived from Fed using APIs

Lotus Word Pro Release 9 Readme.wri This fils contains important information that is not included in the printed documentation or online Help. This file contains
information on the following topics: » Support Information » New Features » Corrections and Additions to Online Help » Tipe and Tricke for Using Word Pro =
Macre and Script Information Support Information >Telephone numbers For all PC desktop products, call Customer Service: 1-800-343-5414, or Technical
Support for all Windows Desktop applications: 1-978-988-2500. The hours arc Monday - Friday, 8:00 am. - 8:00 p.m. (Easter time). *Lotus Customer Support
You can access all avalable customer support numbers in your country by Following the instructions below. 1. In Word Pro, choose Help - Help Topies. 2. Click
the Contents tab. 3. Double-click the Troublesh Help topic. 4. Double-click the Lotus Custorner Support Help topic. 5. Dovble-click the desired country. 6.
Click the desired topic. >Support from CompuServe I you subscribe to CompuServe, yon can download updated LotsSeript Help and other information. In
CompuServe, visit the Word Pro forum (iype "GO WORDPRO"). =Support on the Internet If you have an Internet connection, you can download updated
LotusSeript Help and other information from the Lotus Suppert Web page. To access the Lotus Web page, your computer should have 2 WinSeck-based
connection to the Intemet. Follow the directions provided with your browser for downloading files. The Web site is located at:

httpefwrarr. supp ot lotis. comiftpfpub/desktopiwordpro You can access the same material using an FTP client program. The FTP site is located at:

fip:fiftp. support lobus. com You can find more information about Lotus products and upgrades by going to the Lotus home page. The Lotus Web site is located at
hitpsfiwrwrw. lotus. com ew Features for Word Pro Release 9 * Java integration * Internet Setup Assistant * HTML Export Assistant * High fidelity Internet output
wia Net-Tt * ViaWoice integration * Text wrap around the contours of a graphic * Custom Men Editer * Outline Assistant * Click Here Management * ADA
compliance for users with disabiliiss Cotrestions and Additions to Online Help > TeamMail If you are using Lotus Motes® as your e-mai application, you can use
TeamMail to send selected text in your document out as e-mail. Because DDE only works with Notes, this option is not available with other e-mail applications
>5Tsing TeamMail with Motes for Windows 3.1: Any version of Motes designed for Windows 3.1 requires the following lines in the WIN INT file: [LotusMail]
Progeam=\notes. exe NoDizlogs Application=notes >>Using TeanMail with ceMail 2.3 coMail 2 3 requires the following ines in the WIN.INT file: [Lomshai]
Program=twmail exe SENDMAIL Appl | Mote: Lotus appl designed for Windows 3.1 require the path to the mail program to be listed in the
ATTOEXEC BAT file. When you use Windows 95 or Windows NT with Lotus mail applications designed for Windows 95, it is not necessary to list paths in the
ATUTOEXEC BAT flle. However, clder versions of e Mail (2.1 and earlier) may require this listing, T coMail is not working properly, check the

AUTOEXEC BAT file and malce sure that the path to the co:Mail program is listed correctly. >>Using Teamlail with ITotes v4 or later: TeamMail checks the
registry for information about the installed mail package. Howewver, Notes 4.2 does not write information to the registry. If you are using MNotes 4.x, make sure that
the lines specified above for Notes v3 are in the WIN THT fils. T you are using Wotes 4.1 or later, the registration information is automatically entered in the registry
>Tsing OLE 2 applications with embedded objects When you launch an OLE 2 embedded abject (sither by double-clicking on the object, or by choosing the
object's context-sensitive menu and choosing Edit), Werd Pro launches the application "in place,” and allows you to modify the object When you complete any
modifications, the server application remains in memery, even though it no longer displays. If you are working on a computer with a limited ameunt of memery, you

4 op e it 2

%% Local niranet

s Alnan the o casnnt aPbos o ditine e obinet frebick clan alenns the anssne ceelinatas) o e

E1bore e [
Preview Window Generated by Presentation Template 3 (pr3)

Presentation Template 4 (Pr4)

Presentation template pr 4 illustrates the use of JSP with EIP API functions to perform Content
Manager direct searching in retrieving the content. This sample PT demonstrates that it is possible to
generate a complete JSP file. The code implements direct EIP Java API calls to retrieve the content
rather than using the servlet, and the output is written to the output stream as String. The JSP
generated by this sample presentation template can handle only single-part text contents. The JSP can
be modified to handle other types of contents. The template is listed below:
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<?xm version="1.0" encodi ng="UTF-8"?>
<iw_pt nane = "PressRel ease3">

<l-- HTM. stuff is enclosed in CDATA tag -->
<I[ CDATA[<!-- Begin CDATA tag -->
<HTM.>
<P> <b> Text Retreived from CM using APls </b> </p>
<p>
<%@ page
| anguage="j ava"
i mport="java.util.*, comibmnm beans.*, java.io.*"

%>
<%
CMBConnecti on connBean = nul | ;
CMBConnect i onPool cnPool Bean = nul | ;
String itemd = "]]><iw.val ue nanme="dcr. Textltem /><! [ CDATA[ ";
CMBltemitem = new CMBIten(itemd);

cnmPool Bean = new CMBConnect i onPool () ;

cnPool Bean. set DsType("DL");

cnPool Bean. set MaxFr eeConnecti ons(100);

cnPool Bean. set MaxFr eeConnecti onsPer Useri d( 100) ;

connBean = cnPool Bean. get Connection("libsrvrn","frnadni n", " password");
CwvBDat aManagenent dat aBean = connBean. get Dat aManagenent () ;
dat aBean. set Dat aCbj ect (i ten);
dat aBean.retrieveltem);
CVMBObj ect content = dat aBean. get Content (0);
String nmneType = content.getM nmeType();
response. set Cont ent Type(m nmeType) ;
%
</ p>
<p> <%out.wite(new String(content.getData())); % </p>
</ HTM.>

11>

</iw_pt>
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Using pr 4 to display text content would look like the following:

/kk AW ORKAREA/betty/templatedata. osoft Internet Explorer

L a 2
Back  Fowad  Stop  Fefiesh Home | Seach Favortes Histoy | Mal  Prt  Edf  Discuss
Address |@ |_name=/Fed toliv_i

ORKAREA fbelyhin =] oo ||Links >

Text Retreived from CM using AFTs

*IBM eletwork Personal Communications V4.20 * * for

Windows 95 and Windows NT * * * * Read Me - Please | * * (README TXT) *

First Edition This document contains information
supplementary to the online Help and the Publications, it includes such things as newly-added fanction, hints, tips, restrictions and correstions. For information on
installing Personal Communications, please refer to the online Help for the INSTALL program Thank you for choosing Personal Communications ¥4 21
———— Contents == *IBM Personal Communications Internet Home Page * Installation problems with MS NT V351 Service Pack 4 and MS NT
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Customizing the RetrieveDoc Servlet

About the RetrieveDoc Servlet

Two of the sample presentation templates use the Ret r i eveDoc servlet to retrieve content from EIP
or Content Manager. This servlet requires an item ID (unique content reference ID) plus other
information that is stored in a properties file called i wei p. pr operti es. The location of this
properties file is specified as an initialization parameter called pr opFi | ePat h for the servlet. The
default value for this parameter is set to the root of the directory for EIP Server installation on the
WebSphere Application Server computer (for example, C:\ crbr oot \ | i b). The properties file
contains the following information.

« Root directory—Where EIP Server is installed — C: \ cnbr oot

« Search type—Fed or cM(for federated and Content Manager Direct searches, respectively. Note:
spelling is case-sensitive)

« Server name—Use database if Fed is used or library server name if CMis used)

« User ID—For a federated search, this is the EIP user ID; for searching Content Manager directly,
this is the Content Manager user ID

« Password—rFor the user ID specified

The properties file is read during the servlet loading when the Web application starts. If the user needs
to change any value in i wei p. properti es, stop and restart the Web application that contains this
servlet to reinitialize the servlet after editing the properties file.

Note: A local copy of the i wei p. properti es file is also required on the templating client
computer. The location of the property file is in the Tenpl ati ng cl i ent
di rect or y\ ei pcmdirectory. This file contains all the above parameters plus some other
init parameters for the search Ul. The values for all the above parameters need to match with
the values specified in the i wei p. properti es file on the WebSphere Application Server
computer, except that the search type for Content Manager direct is CMrather than DL.
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RetrieveDoc Usage Scenarios

Scenario 1

Only presentation template pr 1 can be used in this scenario. The Ret r i eveDoc servlet is registered
with the WWeb application called i wei p, which is configured and created during the Turbo installation.
The servlet classpath for the Ret ri eveDoc servletis set to C: \ crbr oot \ 1i b\ i wei p. j ar and
other required JAR files for EIP toolkits, where cnbr oot is the directory for EIP Server installation.
For more information on the classpath and required JAR files, refer to the Managing Enterprise
Information Portal manual or the last section of this chapter for details. This Web application is
configured and tailored to be used for pr 1 within this integration, therefore changes are not allowed.
Thus, in the sample, the full servlet URI is:

http:// <websphere server>:<port>/iwei p/ Retri eveDoc?itemn d=

This makes a hardcode reference to the i wei p Web application and this is intended to be used with a
PT that only generates static HTML pages with embedded single-part plain text documents.

Scenario 2

Presentation template pr 2 generates JSP pages that use the Ret ri eveDoc servlet registered within
the sandbox Web application configured with the workarea. These JSP pages are served up by the
application server at runtime. In pr 2, the image is retrieved by invoking the Ret ri eveDoc servlet
using a relative reference. The servlet in this secenario is registered in the VWeb application (created by
heavy weight sandbox allocation) that connects to the TeamSite workarea. The servlet classpath is set
up during heavyweight sandbox allocation.

For example:

The image will be downloaded by the browser:

<I MG SRC="/RetrieveDoc?iten d=<itenid>">

The text item is retrieved by clicking on the link that refers to:

<A HREF="/Retri eveDoc?i tem d=<i tem d>">| i nk text</A>
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If the item ID for the above text item refers to a single-part document, the document is served
immediately. If the item ID refers to a multi-part document, then the Ret ri eveDoc servlet will
redirect the request to the vi ewf r amres. j sp file to display the multi-part document in a frameset.
This JSP and all the other supporting files are available in the i wei p directory of the workarea
specified during Turbo Installation. This scenario that uses the pr 2 sample PT assumes the use of the
Ret r ei veDoc servlet that comes with the Turbo product and therefore assumes the use of the

vi ewf rane. j sp file aswell. User can choose to customize vi ewf r anes. j sp as needed or replace
it with your own JSP. The name for the customized or replacement JSP for vi ewf r anes. j sp must
be the same, and it must be placed in the i wei p directory of the workarea. Insummary, users are
encouraged to customize the frameset JSPs but the i wei p directory structure and naming convention
of the vi ewf r anes. j sp cannot be changed.

Scenario 3

If users choose not to use the Ret r i eveDoc Servlet shipped with the Turbo, they are encouraged to
develop their own equivalent of this servlet and register it with the Web application that is configured
with their workarea during heavyweight sandbox allocation (must define the new servlet in the
config.xm file). The source code of Ret ri eveDoc servlet is shipped with the Turbo installation
and can be found in the i nst al | / webspher e/ exanpl e/ Ret ri eveDoc_Exanpl e directory.
Users are welcome to refer to this reference implementation. In this scenario, users are no longer
required to use vi ewf r anes. j sp, or any supporting files that reside in the i wei p directory, to
support multi-part document display.

Production Deployment Using RetrieveDoc
Using the Ret ri eveDoc servlet in production that shipped with Turbo product:

« Ensure that the Ret ri eveDoc servlet (or equivalent) is registered with your production \Web
application.

« Ensure that the servlet classpath is set to point to the JAR file containing the servlet or other JAR
files required by EIP APIs. The servlet is packaged in a JAR file called i wei p. j ar that comes
with the Turbo product. User can find a copy of i wei p. j ar residing in the cmbr oot \ i b
directory on the WebSphere Application Server computer (in the development environment
where the Turbo product is installed) where cnbr oot is the EIP server root directory, because this
JAR file will be copied into the above location by the Turbo installation.
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Here is a complete list of all required JAR files by Ret r i eveDoc servlet:

e cnbroot\lib\iweip.jar

e cnbroot\lib\cnb71.jar

e cnbroot\lib\cnbviewrsl.jar
e cnbroot\lib\cnbsdk71.jar
e cnbroot\lib\ics.jar

e cnbroot\lib\xerces.jar

e cnbroot\lib\lotuskns.jar
e cnbroot\lib\essrv.jar

e cnbroot\lib\esclisrv.jar
e cnbroot\java\ldb2j ava. zi p

Note: The Turbo installation will only set up the first four JAR files in the servlet classpath because
the Turbo reference implementation will use only the Content Manager repository. If the EIP
is set up to use a repository other than Content Manager, make sure the servlet classpath
includes the JAR files listed above.

« Ensure that initialization parameter pr opFi | ePat h for the servlet is set up to point to the
i wei p. properti es file in the production environment.

 Ensure that the i wei p directory that contains all related assets for the frameset reside in the top of
the document root.

« Deployment from the TeamSite staging area or edition to a production environment (including
JSPs, HTML, images, servlets, DCRs, and so on) can be accomplished by a combination of tools
using TeamSite OpenDeploy, DataDeploy, and WebSphere publishing tools (mainly registering
servlet and EJBs). Refer to the OpenDeploy Administration Guide and DataDeploy Administration Guide
manuals for details on how to perform deployment from a TeamSite environment to a production
environment.
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Chapter5

Troubleshooting

This chapter identifies some potential problems you might encounter when installing the Turbo
product and when working with the Turbo components, TeamSite, EIP and Content manager. For
each potential error, some general troubleshooting techniques are proposed.

Potential problems (and solutions) include the following:

« Ifyou are able to preview and retrieve content during searching within the templating Java Ul, but
the content is not being displayed during previewing or after page generation of JSP or HTML.

Check that the i wei p. pr operti es files on the WebSphere Application Server and the
Templating Client are set to operate in the same way. The two properties files must be set to access
Content Manager directly or to access EIP; they must be set to the same search type and DB access
information.

 EIP/Content Manager client installation failed.

Templating client program might be running. Close the templating client window.

« Logon failed to server libsrvrn when peforming federated searching.

Sample error message:
com i bm mm beans. CMBExcepti on: Unabl et o connect tothe server.:
java. |l ang. d assNot FoundExcepti on: COM i bm db2. j dbc. app. DB2Dri ver.

Add db2i nst al | di r\j ava\ db2j ava. zi p at the end of the | ax. cl ass. pat h of the
t st. | ax file in the directory where you installed the Templating Client; the default is

c:\Program Fil es\ I nterwoven\ Tenpl ati ngC i ent.
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Click on the DCT search button and nothing happens.

This indicates an installation problem for the Turbo component on the templating client; or may
also indicate faulty configuration. Unfortunately there won’t be any error messages displayed
prompting a return to Templating Java Ul. This might require the user to uninstall and re-install
the Turbo component.

Error 404 while previewing or generating pages from TeamSite.

Make sure you have allocated a heavyweight sandbox to the workarea that you are operating in by
using the special menu item called SandboxPool in the TeamSite Menu bar. Ensure that only
heavyweight sandbox can be used with this version of the integration.

Error 500 while previewing or generating page from TeamSite.

Check for a mismatched search type on the templating client computer and WWebSphere application
server computer. For example, cMdirect on the client and Fed on the server.

Another possibility is the servlet classpath might not be set up correctly; refer to the last section of
Chapter 4 for details on the required servlet classpath.
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Appendix A

Content Manager Sample
Loader Program

The sample loader program, and the files associated with it, are available in the cnsanpl e
subdirectory of the i wei pcl i ent installation directory. Files and directories that are required for
this loading program are:

« i wsanpl e—directory containing the actual data files such as the text, GIF and MPEG files.
« i ndex. exe—the application that creates the index

e | WBAMPLE. dat —input file to the loader program

e | WBAMPLE. | og—Ilog file for the loader program

« | Wsanpl eLoader . cl ass—Java loader program

Ensure that the JDK is included in the environment variable PATH by setting it to include the Java
directory.

Type the following in the command window:

Java —cl asspath <current directory>; <eip root
directory>\lib\cnb71.jar;<eip root directory>\lib\cnmbsdk7l.jar
| Weanpl el oader <library server> <object server> <userid> <password>

Where:

ei proot directory is the directory where EIP is installed
l'i brary server is the name of the library server component
obj ect server is the name of the object server component
useri d is the valid user ID in Content Manager

passwor d is the password for the user ID mentioned above
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A sample command might look like the one below assuming that your current directory is the one that
contains the loader program and related files:

Java —cl asspath .;c:\cnbroot\lib\cnb7l.jar;c:\cnbroot\lib\cnbsdk71.jar
| Weanpl eLoader LI BSRVRN OBJSRVRN frnroot password

This will start the loading program by creating the | WeAMPLE indeX, if it does not exist, and loading
the sample data available in the i wsanpl e directory.

A known issue is that if the index | WBAMPLE does not exist, the program terminates after creating the
index. Executing the program one more time loads the data correctly.

Note: Iflibrary server, obj ect server, useri dand passwor d are omitted from the

command, the default values, respectively, for these arguments are: LI BSRVRN, OBJSRVRN,
f rnadmi n, and passwor d.

72

Interwoven Turbo Product Guide



	Interwoven® Turbo Product Guide
	V2.0
	About This Product
	What is an Interwoven Turbo Product?
	Features of the Turbo Product Family
	Application Server Component
	Personalization Server Component
	Business-User Support

	Architectural Overview
	General Turbo Architecture
	Application Servers and Virtualization

	Who Can Use This Product?
	Business Users
	Templating
	Metadata Capture
	Workflow Approval

	Application Developers
	Presentation Layer Developers

	About This Document

	Introduction
	Overview
	Prerequisite Software
	Prerequisite Hardware
	Architectural Overview

	Installation and Configuration
	System Overview
	Installing Content Manager
	Pre-Installation Procedure
	Installation Procedures
	Removing Content Manager

	Installing EIP on the WebSphere Application Server
	Installing EIP
	Removing EIP

	Installing the Turbo Components
	Installation on the WebSphere Application Server
	Installation
	Uninstalling the Integration Components

	Installation on the TeamSite Server
	Installing the Integration Components
	Uninstalling the Integration Components

	Installation on the TeamSite Templating Client
	Installing EIP—Workstation
	Removing EIP—Workstation
	Creating a Database Client Connection for the EIP Database
	Installing the Turbo Components
	Uninstalling the Turbo Components


	Setting Up Workareas

	Using This Product
	Creating a DCR
	Generating or Previewing DCRs with Presentation Templates
	Customization
	Customizing DCTs
	Data Capture
	TeamSite Data Structure Hierarchy
	Search Application
	Search Results

	Customizing Presentation Templates
	Presentation Template 1 (Pr1)
	Presentation Template 2 (Pr2)
	Presentation Template 3 (Pr3)
	Presentation Template 4 (Pr4)

	Customizing the RetrieveDoc Servlet
	About the RetrieveDoc Servlet
	RetrieveDoc Usage Scenarios
	Production Deployment Using RetrieveDoc



	Troubleshooting
	Content Manager Sample Loader Program


